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SAF Information System
Integrated Management System

The company consists of group of specialists in system applications developers
utilizing the latest application analysis, design and implementation techniques and
tools that covers major areas such as : DATABASE based application system
featuring :Study and analysis of systems.Design of databases and information
systems.Implementation of systems on different platforms.Designing and
programming expert systems.
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— Caps Lock Key Tab Key — Back Space Key Delete Key
When pressed, this key This moves the cursor to a Deletes characters and spaces to This key deletes
locks all alphabetic keys pre-determined position the left of the cursor (in the characters and spaces to
into the ‘uppercase’ mode (tab settings) shown on the direction of the arrow on the key) the right of the cursor
ruler at the top of the page
Escapc Key ‘ Function Keys—l Numeric Key Pad
F4 1T G0 |GH BB == =]
@ S i (EEE TS S
¥ Leck Lock Lock
Al 2 H H H Bk . sHoll =N :MN<—1* [~} & = i
el QlWHENRNTH YUY T OWPY ) J o | (=2 (LR (.
‘- -
A AJSYEDNFRGHHENINKRHLA : , S N
T U R ZRI XA CHvRIBRINE™ME N T 4 M S |
Curl a [ : AR Grll[ 8 = (B 1 I PH | | "l 3 n
I—_A !
Space Bar Shift Keys Return Key Arrow Keys/Cursor Keys
This, as the name Press this key first and hold it down, press any When the Retumn Key is These keys move the cursor in
implies, inserts a space other key to get the ‘v::ppercase’ ol'u.\al particular  pressed the cursor is the direction ?l'the arrow,
between characters or key, ¢.g. when the shift key and ‘8’ is pressed moved to the start of the without deleting any characters
words you will get an asterisk ‘*’, when the shift key and next line. (It also doubles Or spaces
‘" is pressed you will get a capital *T" as an Enter Key)
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1- The DivX allows you to burn discs.
Cigal) el el i 1 ooh Aaganall e i Lady ¢ "GalEY) (3oa 0uS) il o) anss™ © b Al den
Soal Y fed s
2- Online communities can present a risk to your personal information.
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Most internet users belong to an online community to share ideas and information with
people who enjoy similar interests.
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1-online community providers offer several ways to help protect you when you use their

depending upon the kind of community you join<services
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Some groups allow their members to view lists of other group members« screen names and

sometimes their e-mail addresses and full profiles as well in a membership area on the site.

Don’t post information that you're not comfortable sharing with strangers.
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HOW DO PEOPLE USE COMPUTERS?

There are a lot of places where computers are used by people. Stores use computers to keep
track of products and when the costumer checks out at the cash register. Banks use
computers to send money all over the world. Computers help teachers keep track of lessons
and grades. They help students do research and learn. Computers let you hook up to
networks and to the Internet.
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Play multi-computer games.
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It's possible that the family members play games on separate computers through the
Internet or home networks. In addition¢ you could surf the Internet during the game.
For example« you could visit the favorite financial and sports sites.
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Input/output Devices

It is the hardware that is used for providing and receiving information form and to the
computer. It's possible that these devices transfer information in one or two directions
depending on the situation. The hard disk drive is an example of an input/output device.
Some devices which are called input devices can be used only for input. For example« a
keyboard« a mouse« a light pen represents this kind of input device. The output devices

which can be used only for output are« for example« a printer and a monitor.
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Computers are made of
many electronic

components or parts

Every computer needs a
power supply

The motherboard gets
its name because it is like
a mother to all of the
other circuit boards

On the motherboard: you
will find several
expansion cards

The brain of a computer
is the CPU or Central
Processing Unit

A very important
computer component is
the BIOS chip. BIOS
stands for Basic Input
Output System.

RAM stands for Random
Access Memory

The modem is an
expansion card that
allows computers to talk
to each other

Disk drives read
information off of storage
di

The sound card contains
special circuits for
operating the computer's
sound.
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1. On the Settings tab¢< under Screen area¢ drag the slider< and then click
Apply.

ol Jara) Q) df s yal) oy aB ¢ AELAY dalaa ciad e ) gy

2. Your monitor and display adapter determine whether you can change your
screen resolution
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Open a new To open a new
document document choose
New from the File

Menu

dpaglil) jal g¥) 4 alady) Al dlaad) Al ) ghan 5 2 ddaal)

Create a new Press RETURN.
paragraph or blank
line

A galaty) ARl Alaal) Ay ) ) g 8 any Aepl)
Insert text into existing text | Position the insertion point where
and then <you want the new text

type.

il el oY) 4y ARl Alaa) A ) gtaa i n Adan)
Display or hide paragraph | Click the Show/Hide button on

marks the Standard toolbar.

Lpagdail) jal oY) 4 jalady) Aalil dlaad) Al ) Lgan 5 a ddand)
Select a word Double-click the
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word you want to
select.

€

Apagladl] jalg¥) A slady) Ay Alan) Al ) Lgtan 5 any Aland)
Select any amount of text | Drag over the text you want to
or click where you want the «select
holding down <selection to begin
and then click where you «<SHIFT
want the selection to end.

Aaglatl) jalg¥) | A ulady) dadlly dleal) Al ) ghan 5 2y dlaal)
Select a Double-click with
paragraph the pointer to the
left of the
paragraph in the
selection bar. Or
triple-click the
paragraph.

Apalatl) 4ol g¥) [ Aygulady) Aalll Aaad) L) Y tan i 2ay Alaad)
Select entire | Point to the left of
lines the line in the
selection bar« and
then click. To select
more than one line«
select a line« and
then drag up or
down in the
selection bar.

Aaidatl) sal gY) a4 jalady) dally Adaal) A ) ) Lghan i 2y dlaal)

Delete text Select the text« and
then click the Cut
button on the
Standard toolbar.

Aaaglatl) jalg¥) | 4 ulady) dadlly Aaal) dnpd ) e 5 2 ddaal)
Replace text | Select the text¢« and
then type new text.
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Open an
existing
Document

dpaglail) jal g¥)

On the Standard
click the <toolbar
and «Open button
the select the
document name
from the file list. If
you don't see the
«document name
check to make sure
the correct drive and
folder are selected

L) Al Adeal

Al ) Lghan i 2y Alanl)

Move or
copy text

Aaglail) el Y

Select the text « then
drag the selection to
a new location. To
copy text¢ hold down
OPTION while
dragging the text.

&y lay) Rl Alea)

Al ) Lghan 5 am Adan)

Activate the
smart-cut-
and-paste
feature

dagadl) ya) Y

From the tools
menu« choose
Options. Click the
Edit tab« and then
select the Use Smart
Cut And Paste

option. Click OK.

A jalady) A2l dlaad)

Ayl ) gian i 22y Aland)

Center text

Select the text and click the Center

button on the Formatting toolbar.

4l iy) el ALaa Ll ) Lgten 5 g el
Click the Insert Table button and drag
a grid the size and shape you want for

your table.

dagadl) ja) Y
Create a table
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Adjust spacing From the Format menu« choose
between paragraphs Paragraph. Select the spacing you
want in the Spacing area.

Tpaghalll ) 53) Tl Ty) AL At B al) Y Lgen i day Alaal)
To merge text form With both documents open:« select text
one document to from document one« click the copy
another document button. From the Window menu select
document two« place cursor in
documents two- select the Paste
button.

Apaglatl) jalg¥) | & ulady) dadlly dlaal) Al ) ghan 5 2y dlaal)
Adjust line From the Format
spacing menu« choose
within a Paragraph. Select
paragraph the line spacing you
want in the Line
Space area.

Aadlal) sal gY) 4allly dlaal) ) ) Lghan i ey dlaal)
4 iy
Sort text in a list | From the Table
menu« choose
Sort Text.

Lpaglail) jal gY) dallly dlaal) Al ) ghan 5 2y ddaal)
A alay)

Set custom Drag the

indents triangular indent
markers on the
ruler to set the
first-line« left:
and right indents.
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Microsoft Office Word

= word Home:

Product Information
& Cverview

= Top 10 Benefits

® Zompare Features

» Product Dema

& Try Mow

# By Mow

Help and How-to

= Word 2007 Help

= W'ord 2003 Help

= Word 2002 Help

» Word 2000 Help
Choose your version
Training

= Word 2007 Training
» Word 2003 Training
» Word 2007 Demos
» Word 2003 Demos
Templates

» Templates for Ward

= Submit a Template

Support and
Feedback

» Product Suppaort

Horme = Products = Word = Word 2003 Help and Howe-to = Startup and Settings = Installing and Custarnizing

Toolbars and Commands

Documents 1-25 of 29

@l about menus and koolbars

@ Animate menus

@ hange the size of a koolbar bukkan ar drop-dawn list bax
@l Add a button, menu, or command

@ Items that appear in the status bar

@ Shew or hide shorkout kevs in ScreenTips

@l Demo; Find toolbars and butkons in Office

@ Delete a button or menu command

@l Show Standard and Formatting toolbars on bwa raws

@ Delete a toolbar o menu

@ Display an icon, text or bath an a menu cormmand or butkon
@l hange a picture on a butkon

@ Create a cuskom toolbar

@ Group related buttons and menus on a toolbar

@l Mave a submenu anywhere on the screen

@ Assign a hyperlink to a toolbar button or menu command

@l Customize a shortout menu
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Make Data Disc

Make Audio and Da..
CD

=% "Nero Express
Disc Content

Add data to your disc.

]’;?' My Disc

Mame “3 Size Tawe Mo...

Total space used:
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MB 200MEB 400MB 600MB E S00MB LEME

0 Ee @

H Save ] lg Back ]I Next 0_/1]
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[**"Nero Express
Disc Content

Add data to your disc.

[CE’_) My Disc

Mame 3 Size oo Mo...
) i2sdkl.4.0-rc 61 MB File Fol... 11j11j14... I

200MB 400MB

Ig Nero I I More>>

I L. Save
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Final Burn Settings
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Current recorder: Options
Disc name:
Title [CD TEXT])
Pt CO TEXT] I I
Language:
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What is an Operating System?

The most important program on any computer is
the Operating System or OS. The OS is a large
program made up of many smaller programs that
control how the CPU communicates with other
hardware components. It also makes computers
easier to operate by people who don't understand
operating «programming languages. In other words
systems make computers user friendly.

¢ ) yall
Do you remember ROM (Read Only Memory) and
RAM (Random Access Memory) from Lesson 2?
ROM and RAM are very important to the OS. Part
of a computer's operating system is built into ROM.
That part contains the most essential programs that
the computer needs in order to run correctly. The
ROM operating system is also known as the BIOS
(Basic Input Output System). You may remember
from Lesson 2 that the BIOS is responsible for
waking up the computer when you turn it on to
remind it of all the parts it has and what they do.
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Types of Operating Systems

Different computer manufacturers use different
operating systems. Apple has specific operating
systems for its line of Macintosh computers. When
IBM released their Personal Computer or PC back in
the early 1980's« they did not get a copyright on it«
which allowed many other companies to build similar
computers that were IBM-compatible; in other words:«
they used the same operating system as the IBM PC.
There are different operating systems available for
PCs:« but the most common is Windows« which was
developed by a company named Microsoft. Windows
is similar to the Macintosh operating system« because
it also uses a mouse and a GUI (Graphical User
Interface) that uses graphics or pictures to help the
user navigate within the computer system.

¢ i) padl

The Computer Revolution

The introduction of the Macintosh OS and the later
introduction of Windows played a large part in
making computers accessible to so many people.
The user-friendly interfaces of both operating
systems made it easier for people with no computer
training to learn to use these amazing machines.
such as typewriters and payroll <Other machines
as «calculators quickly became a thing of the past
computers became so easy to use and so
affordable.
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Home > Products > Word > Word 2003 Help and How-to > Word and the Web > Creating Web
Pages

Printer-Friendly Version
Create a Web page
Applies to: Microsoft Office Word 2003

EIHide All

Do one of the following:

[=ICreate a Web page based on a template

cilada gldd) > cugy > Word Word 20034 "aius™ ciliag cilaglal > Word > clailall > 4yl
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: Microsoft Office Word 2003 s (s
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On the File menu:« click New.

In the New Document task pane (task pane: A window within an Office application that provides
commonly used commands. Its location and small size allow you to use these commands while

still working on your files.)c under Templates:« click On my computer.

On the General tab¢« double-click the Web Page template (template: A file or files that contain
the structure and tools for shaping such elements as the style and page layout of finished files.

For example« Word templates can shape a single document« and FrontPage templates can

shape an entire Web site.).
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= Create a blank Web page

On the File menu: click New.

Under New in the New Document task pane (task pane: A window within an Office application

that provides commonly used commands. Its location and small size allow you to use these

commands while still working on your files.)« click Web page.
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If you're already working on a Web page« you can click New Web Page on the Standard
toolbar (toolbar: A bar with buttons and options that you use to carry out commands. To display a

toolbar« press ALT and then SHIFT+F10.).
=l Create a Web page from an existing Microsoft Word document
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On the File menu:« click New.

In the New Document task pane (task pane: A window within an Office application that provides
commonly used commands. Its location and small size allow you to use these commands while

still working on your files.)« click From existing document.

Select the document that you want to base your Web page on« and then click Create New.
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Note The existing document does not need to be a Web page. To create the new Web page: click

Save as Web Page on the File menu.

=l Create multiple Web pages from multiple existing Word documents
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Place the documents you want to convert in a single folder.
On the File menu: click New.

In the New Document task pane (task pane: A window within an Office application that provides
commonly used commands. Its location and small size allow you to use these commands while

still working on your files.)c under Templates« click On my computer.

Click the Other Documents tab.

Double-click Batch Conversion Wizard.
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Note If you do not see Batch Conversion Wizard in the Templates dialog box« you may need to

install it.

Follow the directions on the screen.
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Create number
lists

dpaglaill yal gY)

Select the
paragraphs to

format« and click
the Numbering

button.

Ay ey Rl Alea)

Fa ) ) \ghen iy Alaadl

Create bullet
lists

dpagatl) ya) oY

Select the
paragraphs to
format« and click
the Bullets button.

FRTIFIP
4y

Zap ) ) (ghian 5 any Alea)

Check and
correct the
spelling in a
document

dpalail) el oY)

On the Standard
toolbar: click the
Spelling button:¢
and then change
or ignore words
as Word selects
them.

FRTIFTPN
A jatay)

Anad) ) Lgtan 5 an Alan)

Scroll through a
document

danal) jal ¥

Click the scroll
arrows on the
scroll bar« drag
the scroll box« or
click above or
below the scroll
box.

T3, Alea)
4 iy

Ty ) ) Lghan i 2y Alanl)

Save a new
document

Click the Save

button« and then
type a name that
has a maximum
of 31 characters.
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Aralail) jal oY) 4 alady) dadily ddaal) Al ) Lhea 5 2y dlaal)
Reverse an Click the Redo
undo action button

immediately after
an undo action.

Apaglail) jalg¥) | A alady) A3l dlead) Al ) Lghan 5 any ddanl)
Save a Word Choose Save
document from the File
menu. If itis a
new document
enter the
document name
and place the
document on your
destination disk
by using the Save
As dialog. See
SAVE handout
for more
instructions.

dpaplail) yal oY) 4y ulady) dadlly ey Al ) ghan 5 2 ddaad)
Change the case of text Select the text to change.
From the Format menus«
choose Change Case. Select
the desired case option.
Click OK.

Tpaglail) ol 31 Ay plady) A3l Alaad) Tl ) s 5 aay Alea)
Change a font or point Select the text:« click the
size down arrow next to the Font
or Font Size list box« and
then select a font or point
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Apply bold:« italice Select the text« then
or underlining click buttons on the
Formatting toolbar.
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A local area network
[LAN] is computer
network covering a small
geographical area- like a
home: or office or group
buildings. Current LANSs
are most likely to be based
on switched Ethernet
technology:« running at10-
100 or 1<000 Mbit/s or no
Wi-Fi technology. Each
node or computer in the
LAN has its own
computing power but it
can also access other
devices on the LAN
subject to permissions it
has been allowed. These
could include data«
processing power and the
ability to communicate or
chat with other users in the
network. The defining
characteristics of LANSs
are different from WANS
[wide area network].

LAN
Alaall 45,30

Ethernet
technology

Mbit/s

Wi-fi technology
sl ) ) A

Devices
<l oY)

WAN
Sl 5l) AL
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Although
switched
Ethernet is now
the most common
data link layer
protocol [OSI-
layer Model] and
IP as a network
layer protocol«
many different
options have
been used some
continued to be
popular in niche
areas. Small
LANSs consists of
a few switches
typically
connected to each
other and one
connected to a
router« cable
modem: or DSL
modem. A
traditional model
of access«
distribution and
switches was
used popularized
by Cisco systems
and has been
used for many
years.

Protocol
JsS g3

IP

(.,u;.s

JsS 55
Ca ).\.\\

Router
sl

Cable
modem
éLn eJ}A
DSL
modem
u.n\ g;d eJ}A

J
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One might think of
computer virus as a
tiny computer
program to
perform a
mischief.
Computer virus is a
result of a
destructive
program that
someone has
written and placed
inside a computer
program < which
unsuspecting
people then place
in their computer
system. Some
viruses can erase
all the information
from the place it is
stored on the
computer's hard
disk. But each
virus is different:
some display
strange message on
the computer's
screen; others
make small
changes in your
computer program.
people get
contaminated
computer programs
by trading
programs; others
do by the use of

Virus
orgd

Computer
program
el

Computer

system

Hard disk
clall pa a8l

Contaminate
d programs
4 sl gl 2
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Software is a program that
enables a computer to
perform a specific task« as
apposed to the physical
components of the system
[hardware]. This include
application software such
as a word processor« which
enables the user to performe
and a system software such
as an operating software«
which enables the software
to the properly by
interfacing with hardware
and with other software.
Practical computer systems
are divided into three
classes: system software«
programming software and
application software.

Software
Sl all

Hardware
3)’.@;?\

Operating
software
S.. . &..x‘ ?‘ﬁ

System
software

Application
software
il ol )
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This is particularly true for the human element. Behavior and awareness of affiliation —
thus his individual interest is suited with the common interest — are considered main
determinate of productivity differentials between various communities.
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RAM & ROM

Have you ever heard the terms RAM and

ROM? These two terms sound very similar
and can easily be confused by beginners.

understanding what they mean <However

and what they do can help you to 2y 2l ) 388 Ay i3
remember.
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A program is a set of instructions that tells
the computer how to perform a specific task.
For example« your favorite computer game
is a program. In order for your computer to
know how to play that game« you (or your
parents) must first install the program from A ) o 3adll daa 5
the game software - usually a CD. Installing
the program means that you are copying the
program or instructions that are stored on
the CD on to your computer's hard drive.
Programs can also be downloaded from the
internet directly to your hard drive.

4 jalayy Al 5 jaal ) dan il Jdlae
3 Jlial)
(=925

Types of Programs

There are many different types of programs for the
computer. They are grouped according to the tasks
that they perform. Here are some very common types
of programs and some examples of their uses:

Dl 1 5 A Laa 5

Word processing - letter writing« essays:«
writing stories

Database - address books« mailing lists
Spreadsheets - storing financial information
Research - encyclopedias« informational
programs

Entertainment - games« music/video
programs

Education - skill practice games: tutorials«
how-to programs

Desktop Publishing - creating birthday cards:
newsletters:« etc.

4 jalaiy) Al 5 jaal ASE Jiia) ) dan il Jolaa
(=325l Jiaal)

Programming
2All of the information that travels through
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your computer is stored on bits as either
an on or off signal. Using bits and bytes in
different combinations to represent a
code is known as programming. These
codes allow the computer to understand
instructions. Computer programmers are
people who write these codes to create
programs. There are even programming
languages that make it easier< so that
these people don't have to remember all
the bit or byte  combinations.
Programming allows people and
computers to communicate more easily.

dally 5_jadl 38481 (e B lida cilathiaa
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Programs

do much of
the work for

when <us

we perform
tasks on the

Dl 1 5 i) Laa 5

computer.

The

program
instructs the
computer in
a language
that it
understands
. Think of
how hard it
would be to
dictate a
story for
someone
else to type
if that other
person
spoke a
foreign
language!
You could
learn that
person's
<anguage
but that
could take
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years. The
easiest way
would be to
have a
translator.
Programs
are like
translators
that allow

people to
work with

computers
without
learning the
computer's
language.

99



- o o - e

dradlil) < jadl) : -4

(A5 SIS Sl o Aslall pa palll Ao paga i UAS‘-J Joha D Jage i g QaAlll
_lsdy C\)A.\ul‘ 5\c&y.4‘9d\uldl;.du.\ew.\ﬂ\ At Ay <8 ddee adlll of iV uaaﬂel.d\ &Mﬂ\
sSY) (ol Aadli das i Lla¥) A8 B GgiSa L pal daa iy bl g3 4 dlil) day il Lal, A )
DSl oo ) ga al) pail) 85980 AT Jualdl B Jadall ()9 dageal) BB g dpeni sl LSEY) daa iy
ASal Aaga 2o g8 Alaal) oda puadiy, La¥) Galll ¢ %25 5 %30 s e LS ax el IS L g i
T S s La JS Jalady o lal) pall) (e dpi ) JSEY) addiu o aa el 38 agall (el Jand) 138
G G O tfiacpan slal) (e pladil) o peanll By dpadlil) daa il o) 2ad ddy Uy puball) £ g gal)
a.daﬂ\u‘g.\ﬁuAL\.\Gwijﬁh‘ﬂuNJYuwyjthj@wﬂuﬂ‘M\hﬂh\yﬂ! 38 o culiy
Juelly adeYSdipnall aghall B 5 Casal Luadlil) dap il 8 ¢ "o jul) pae™ M Ujas S U
L,LLAA.\«A.\ALJ\ daa i) i) i) a9, agad) g ol ) jlatid) dudawd) g 4 jlail)
oy Alal Be) 85 841 Be) 3 e
parall B Ll (o Gl Gk e Basal) cilaldl) ) A%
LBARY (pa Ayl 588N &) )
Llalgdiay) Ao g ALGYIS 4y g pa pdd) £LIEY) g Aila) B SAN agdl 5 59 02 9& La Gy Sl
Ally ARl i ghdl) alad) aay Lila Al palll & 5 Ble) e pa B ARN (e Al LSEY) AL
o) Gl ) el alll Bagadl e adle W9 can siall A siud La (389 pandlil) A
(O gaaally JNAY) ase g Lgd Lo ) JISEY) anan o Lgllaid) 2l Apadtil) Aoy ill Apilgi 3l B o

-4l Anandltil) ABaY) Jalay W) il

A Jha
Iy
¢! Windows*®
—— Digital photography
]6 _The features in Windows XP make it easy to transfer pictures

directly from your digital camera to your computer and even

organize and share your photos.
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“7 Games for Windows

" Games for Windows open a wide world of fantasy and adventure. Take a
break from reality and have fun with friends and family at any age.
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ii: Making movies
' With Windows Movie Maker«< you can use your computer to create and
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edit home movies with a few simple drag-and-drop moves. Then you
can share your movies through the web« e-mail< your computer« or CD.
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Music and video
With its fast and flexible playback features< Windows Media Player
makes it easy to enjoy your favorite music and movies whenever you

like.
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g™ TV and multimedia
87 Take advantage of these resources to get the most out of your Media

Center personal computer.
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Instant messaging
i Windows Messenger lets you instantly communicate with friends and

family all around the world from your computer«< using text chat and
even voice and video.
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). Security and privacy
J Learn to keep your computer and personal data more secure with

Windows XP.
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r . Computer setup and maintenance

1l . . . .
=" Learn how to set up« personalize« and maintain your computer running
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Windows XP.
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:) Home and small office networking

% Networks let you share files«< printers« and other peripherals. Get the

information you need to set up and maintain your own network.
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— 32 Pen and ink
ﬁ Find out how to put the features of Windows XP Tablet PC Edition to
work for you.
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A = Working remotely
\78 Get as much work done on the road as you can in the office. Find out
how to use the mobility features of Windows XP Professional.
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A’ Accessibility
- Accessibility features in Windows XP make it easier for people with
accessibility needs to work efficiently.
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Internet tips
Find time-saving tips for browsing the web using Windows XP.
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As of June 2006« Hotmail users can now send instant messages from within
Hotmail using the integrated Web Messenger function«< without having to be
signed in to Windows Live Messenger or have the program installed at all.

At the Hotmail main screen« users can access integrated MSN services such as
Calendar and Contacts (the latter being shared with Windows Live Messenger).

In December 2004« Microsoft started its new service called MSN Spaces and
integrated it with Windows Live Messenger and MSN Hotmail..

In the past« Hotmail has offered users who have held the same account for a
number of years the same exemption from deactivation. However« Hotmail
changed its policy again« leaving many of those account members surprised to
find that« after being told their emails would be saved: they had instead been
deleted. Those emails cannot be recovered.
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MouseStar is a powerful application that transforms your mouse into a highly
functional tool. MouseStar includes a suite of productive tools packaged as an
easy-to-use application.

Features include MOVE SCROLL« LOCK COMPUTER¢< EJECT/CLOSE CD-
ROM...c and its outstanding SCROLL feature will make your work easier and more
productive.

Major Features:

@ Very easy-to-use and comfortable scroll function« even better than a scroll-
mouse. Scroll feature supports almost all program which need to scroll window .
@ Hide mouse cursor while typing« in case the cursor obstruct the text you are
typing

Lock computer immediately if you will be away from computer for a while

@ Swap mouse LEFT/RIGHT button

@ Snap to default button

@ Eject or close CD-ROM .

(]

s cliadla 1Y
liaall (B Jlad) oa LaS daa i) B Jaid ¢ A el 4l B ( mousestar ) au¥ Jila 22 Y e
il 141 Ak s AT cOliha Lgd 58 2 3
S ) L) g a3 paal dadiall Gl ay g ) WD jdise Jasad Auald (Scroll ) @ xaly o
L Jiad

daa il ;LG

138 Sadyg dslas S B1af ¢y 983 (S By gal Yiad Ul a5 (Sl (ugla) dpnald ()
AR S Uit ¢y 531 dacine Aaiall g (ha A6 gana (Gl

fiow JSdy dadall Gy U & adadl B Jdise kil 1A pailed Gadily
Apaldl) cSaiy 13n , gadall o Al 33 8al) 58I ) Aly (DE) duald Ly alilag
Asall) STy Qg IS Jard) (e padical) A oY)

: Ageagi ) il palle

Juabl g Aall dag e g aladiad) Al Ak dadall BN (aje didig 25 @
LS ¢ lglind ) dadal) o g g JATE g 5L aladia) 3ja (e S
 Jedhgl e &gl cladall (a e dualdl) o2y g

Aol g (e Jia pdial) S Al b dslhl) Jla BN jdise slEL) e

) . pall

5 5 500 g Ty priiendl) (58 s B 55 gl 32

sl g el U )5 aladiad (B Jla) g ) dsald

O Jlaa) D L slad ey

L Ll Al e 2 81 3 03 S

104




Elins L c2) 99 b g g sSila gl o e liladial) cliad Juay Jghaa (oLl Jild (gmils el 9 2 5s 14 JUa

Ja (0 Ao A il ) S 56l i) o 3 ot e ) s A i gl g sl a5

DivX gabig ¢ Al paslall g Jas A g al) g dnld) el jaall o i g5 il g ardioual) o Jagdl
;e galll b il

Divx Pro for windows includes the Divx Pro Codec: Divx player« Divx Web player and the Divx converter«
providing all you need to create« play« manage and burn Divx videos.

The Divx converter allows you to convert all Divx vides .In easy steps. Simply drag your video onto the Divx
converter and click 'convert' .videos created with the Divx converter will play back on millions of certified devices.
the Divx player lets you play all Divx videos .This includes every version of Divx video; even purchased or rented
Divx movies« Divx HD files .and videos created with advanced features such as menus «subtitles and more. The
Divx player for windows also lets you create playlistsc manage video collections« burn discs and activate Divx
certified devices.

The Divx web player is a versatile utility that allows you to watch Divx videos from within your web browser and
embed Divx videos directly on to a web page or social networking profile.

Also included in Divx Pro for windows is the Divx Pro codec« an advanced digital video codec (coder/decoder) that
plugs into popular video software applications. When used in combination with your existing video software« Divx
Pro allows you to create and play high-quality Divx videos and provides playback support for interactive video
menus «subtitles« alternate audio tracks and more. Divx technology can compress digital videos 5 to 10 times more
than the MPEG-2/DVD format and hundreds of times over row digital video.

The latest version of the Divx Pro codec for windows offers multi-threading support« giving you better performance
on al hyper threaded .dual core and dual CPU (SMP) systems. Depending in your system configuration« you can get
up to 350% better performance than Divx 6.0 when using the higher quality encoding modes. Only have a single
CPU? Don t worry we haven t left you behind. The latest version of Divx is significantly faster than 6.0 across the
board
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1985: Windows 1.0

The first version of Windows provided a new software environment for developing and running
applications that use bitmap displays and mouse pointing devices. Before Windows« PC users relied on
the MS-DOS® method of typing commands at the C prompt (C:\). With Windows: users moved a mouse
to point and click their way through tasks: such as starting applications.

1987: Windows 2.0

Windows 2.0 took advantage of the improved processing speed of the Intel 286 processor< expanded
memory« and inter-application communication capabilities made possible through Dynamic Data
Exchange (DDE). With improved graphics support¢ users could now overlap windows« control screen
layout« and use keyboard combinations to move rapidly through Windows operations. Many developers
wrote their first Windows—based applications for this release.

1990: Windows 3.0

The third major release of the Windows platform from Microsoft offered improved performance:«
advanced graphics with 16 colors« and full support of the more powerful Intel 386 processor. A new wave
of 386 PCs helped drive the popularity of Windows 3.0« which offered a wide range of useful features
and capabilities¢ including:

1995: Windows 95

Windows 95 was the successor to the three existing general-purpose desktop operating systems from
Microsoft—Windows 3.1¢ Windows for Workgroups: and MS-DOS. Windows 95 integrated a 32-bit
TCP/IP (Transmission Control Protocol/Internet Protocol) stack for built-in Internet support¢ dial-up
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networking« and new Plug and Play capabilities that made it easy for users to install hardware and
software.

1998: Windows 98

Windows 98 was the upgrade from Windows 95. Described as an operating system that "Works Better«
Plays Better<" Windows 98 was the first version of Windows designed specifically for consumers.

2000: Windows Millennium Edition (Windows Me)

Designed for home computer users¢ Windows Me offered consumers numerous music¢ video« and home
networking enhancements and reliability improvements.

2000: Windows 2000 Professional

More than just the upgrade to Windows NT Workstation 4.0¢ Windows 2000 Professional was also
designed to replace Windows 95¢ Windows 98¢ and Windows NT Workstation 4.0 on all business
desktops and laptops. Built on top of the proven Windows NT Workstation 4.0 code base< Windows 2000
added major improvements in reliability« ease of use« Internet compatibility< and support for mobile
computing.

2001: Windows XP Professional

Windows XP Professional brings the solid foundation of Windows 2000 to the PC desktop« enhancing
reliability« security« and performance. With a fresh visual design< Windows XP Professional includes
features for business and advanced home computing« including remote desktop support¢ an encrypting file
system« and system restore and advanced networking features. Key enhancements for mobile users
include wireless 802.1x networking support« Windows Messenger« and Remote Assistance.
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2001: Windows XP Home Edition

Windows XP Home Edition offers a clean< simplified visual design that makes frequently used features
more accessible. Designed for home users« the product offers such enhancements as the Network Setup
Wizard« Windows Media Player< Windows Movie Maker« and enhanced digital photo capabilities.

2002: Windows XP Tablet PC Edition

The long-held industry vision of mainstream pen-based computing became a reality when Microsoft
unveiled the Windows XP Tablet PC Edition in November< 2002. The logical evolution of notebook
computers: Tablet PCs include a digital pen for handwriting recognition capabilities« yet can be used with
a keyboard or mouse:« too.
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The first computer was mainly used for numerical calculations.
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The Transistor was invented in 1948. .1

the Transistor was invented.<In 1948 .2

The transistor in 1948 was invented. .3
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1. American physicists Walter Brattainc John Bardeen:¢ and William Shockley
developed the transistor.
2. The transistor was developed by the American physicists Walter Brattain< John
Bardeen< and William Shockley.
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Since | travel a lot¢ | have bought a new notebook. | need it to perform my works. It's very
useful. It keeps much of my time« but | am sick of its heavy weight and fast consuming of
batteries.
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1. ACPU is similar in its work to a calculator« only (but) its more powerful.
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Malware is a software designed to
infiltrate or damage a computer
system without the owner's
informed consent. Itis a
portmanteau of the words
(malicious) and (software). The
expression a general term used by
computer professionals to mean a
«variety of forms of a hostile
intrusive or annoying software.
Software is considered malware
based on the perceived intent of
the creator rather than any
particular features. It includes
Trojan horses and « worms«viruses
spyware. In low malware is
sometimes known as a computer
contaminate.

Malware
Lipal) gl )

Worms
A gl lanall

Trojan horse
Bd‘j).b UL‘A;

Spyware
ol el

computer
contaminate
AR PEWIN
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Today's Internet Internet----------- | eccmmmmmeee
A rack of servers Aside
from the complex physical bi- or multi-lateral commercial
connections that make up contracts

its infrastructure« the
Internet is facilitated by bi- | | Ommmmmmmmmmmmmmmm s | e
or multi-lateral commercial Protocols | | -

contracts (e.g.< peering | —mmmmemmmeeee-
agreements¢) and by network----------

technical specifications or interconnections routing policies
Protocols that describe how
to exchange data over the
network. Indeed« the
Internet is essentially
defined by its
interconnections and
routing policies.
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Many
individuals and
some companies
and groups have
adopted the use
of "Web logs" or
blogs which are
largely used as
easily-updatable
online  diaries.

Some

commercial
organizations
encourage staff
to fill them with
advice on their
areas of
specialization in
the hope that
visitors will be
impressed by the
expert
knowledge and
free information
and be attracted
to the
corporation as a
result.

Web logs
easily-updatable online diaries
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A vector case | Vector------- S —
study shows | ----80x86 | | e e
how new | and Y o e
functionality | PowerPC
can be added | architectures | | TTTTTTTTTTTTTTTTTTTTTTTTTTTTT I B [ B -
to extend the | --------------- e [ e e e -

80x86 and
PowerPC
architectures
to support a
full vector
<architecture
primarily by
enhancing
their
multimedia
extensions to
provide a
better model
for compilers
and an easier-
to-understand
model for
programmers.

multimedia
extensions--
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Open standards« open
source software« and
Web applications are
causing a major shift
in the way enterprises
manage software.
Whereas companies
have traditionally
been tied to a
particular vendor and
upgraded their
software only when
new versions became
available« they are
increasingly able to
change software
stacks with less fear of
disruption due to
incompatibilities or
contractual
hindrances. More
businesses also have
the choice of using
Web applications that
require only a browser
instead of using
software maintained
on local PCs.

Software

vendor
software stacks
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Excell gl ¢ 4l 3 381 aa 5.2
Spreadsheet is the computer equivalent of a paper ledger sheet. It consists of a grid made
from columns and rows. It is an environment that can make number manipulation easy
and somewhat painless.

papes|fedges. A | B | C |
1 computer ledger
eax P 57 2000 _2 |
— ; 9.677 3 car loan $12,000.00
= 7 z 4 interest 9.60%
ef F'aﬁ'""“ql"f"’ 5 * of payments 11}
0]
meonthly phyneent | 5252.6F 7 Monthly Pmt. $252.61

The math that goes on behind the scenes on the paper ledger can be overwhelming. If you
you will have to start the math all over again (from scratch). But «change the loan amount
lets take a closer look at the computer version.
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For this special hardcover edition< two new appendices on locales and standard library
exception safety have been added. The result is complete« authoritative coverage of the C++
language:« its standard library< and key design techniques. Basd on the ANSI/ISO C++
standard« The C++ Programming Language provides current and comprehensive coverage
of all C++ language features and standard library components .

/* my second program in C++

with more comments */

#include <iostream>

using namespace std;

int main (){

cout << ""Hello World! **;  // prints Hello World!

cout << "'I'm a C++ program'; // prints I'm a C++ program
return 0;

rdaa il

S 5 Aaally (g baal) iSal) CY) § gaga (B Buaa ciliale QL) caad 28D (aldd) GUISH 13 laaY dpwilly
Aol psasalil) dﬁjﬁj}d\hbﬁbﬁj\ CH+ Axd daa yy Glis ;@32«.\‘153\4.,&5\

Ll e b 3al) @a G Aa ) Aily (gl Lagd BN el

namespace std; alsdiuly jostream Jeady #

(pledls La je)ds b, allally Lia je Cout () i) INt

( c++Ui dsld) c++ LW Cout

- (0 )z

2(Jdal akii)) e

Operating systems provide a software platform on top of which other programs« called
applicatio n programs« can run. The application programs must be written to run on top
of a particular operating system. Your choice of operating system:« therefore« determines to
a great extent the applications you can run. For PCs« the most popular operating systems
are DOS¢< OS/2¢« and Windows:« but others are available« such as Linux.

161



http://www.webopedia.com/TERM/o/software.htm
http://www.webopedia.com/TERM/o/platform.htm
http://www.webopedia.com/TERM/o/application.htm
http://www.webopedia.com/TERM/o/PC.htm
http://www.webopedia.com/TERM/o/OS_2.htm
http://www.webopedia.com/TERM/o/Windows.htm
http://www.webopedia.com/TERM/o/Linux.htm

rdan A1

i Al mal ) @) Cua (liadilll) pand g g AY) gl ) e Jard L ) Lol S i A5
iy, gl aBl) 03gd (S (Al el dmy (ga ) daad Lgilh Al g Alsma Sl daiif o Jaatd Lgtiaa
LinuxsWINDOWS:OS/2¢DOS i Jaiuitll Aalail gl ¢)ld 4y 53 gana oS 3 jga S

rdakall) (g giea Ao Jahddl) adii g daua pull cla gy daa 5 (B Liigal g Al) Jolall g JSliall (lary 1l

axsiall Ol Las Y an siall daudal g yd) Al <l jlamd) g <l LAY (e B _yS As gana o aa jial) yail) ) gia)
AU ) ol caladly B jusilaa ABMe AT () 9S5 Y 28

(CH+ Galadl JUial) )3 RGN Balna duaa s Jgay A L) SiaY CH+ Jia donaal) dall) dag ji e 3,480 axe
Cpeudigally Crappal) A Jan Basaa (1080 8 aa jal) o Ay Byaa L dale clajhe o (all) (g gl
St Ll g Lale lallias 50 q s Le dpallal) 4580 2600 La gy 4d) i pa jally ellly Lad agud

oal daa il ol Sy LBl dan ) Ailes Jpgauttd Ajand) 45800 B 5 pd A5 VL) (B dan ) ks
LSl sy La Lablal g (e 28U Alaadly 3 gaclal) (o Ciall Ude 488 Jadil) A% ABMe o3 ol e
 Agliiall laal) a3k g 48Tl BUANY) 4gLid g aal) Aia 93 )

(S 0 Gl e Lagd) Eua (Motherboard a¥) 4a sl ) Jia 48 sall g Sua) 4y jlaall il jdall (o Jalid)

A (C++) Jie ax sially galad) addiciall daggda pad) i) of g adl g ol JLaid) Jiig dan 55 pal B 3 sl
(FH e CHe Aol Aad) oa Algdl) B JuadY) o LAES) W pa (b o Aa ) A3d ) J 685 g) (o LaS Lglals

162




el yaill

Sy )35 A4-5

Lo All oL dag i) 8L Jasgal Lgrladding Al Ciliasil iad) 330 g A adl A AN e galll an 5 I

Lalidal) cilals)
W ol Sl
Glaead)

Aol ) 4 i day oall

The mobile
Internet

The Internet
can now be
accessed
virtually
anywhere by
numerous
means. Mobile
phones: data
cards:
handheld
game
consoles and
cellular
routers allow
users to connect
to the Internet
from anywhere
there is a
cellular
network
supporting that
device’s
technology.

data cards

handheld game
consoles

cellular routers
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Motherboard

The motherboard (or mainboard) is the primary circuit board
within a personal computer. Many other components connect
directly or indirectly to the motherboard. Motherboards
usually contain one or more CPUs« supporting circuitry -
usually (I1Cs) providing the interface between the CPU
memory and input/output peripheral circuits« main memory:«
and facilities for initial setup of the computer immediately
after being powered on (often called boot firmware or« in
IBM PC compatible computers« a BIOS). In many portable
and embedded personal computers« the motherboard houses
nearly all of the PC's core components. Often a motherboard
will also contain one or more peripheral buses and physical
connectors for expansion purposes. Sometimes a secondary
daughter board is connected with the motherboard to provide
further expandability or to satisfy space constraints.

Daughterboard:
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User-written software

User software tailors systems to
meet the users specific needs.
User software include spreadsheet
word processor <templates

« scientific simulationssmacros
and scripts for graphics and
animations. Even email filters are
a kind of user software. Users
create this software themselves
and often overlook how important
it is. Depending on how
competently the user-written
software has been integrated into
«purchased application packages
many users may not be aware of
the distinction between the

and what <purchased packages
has been added by fellow co-
workers.

User-written software:
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Spreadsheet
templates:
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Word processor
macros:
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Scientific simulations:
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Email filters:
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Application packages:
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Video card

The video
card -
otherwise
called a
graphics
card:
graphics
adapter or
video
adapter -
processes
and renders
the graphics
output from
the computer
to the
computer
display:«
also called
(VDU)« and
isan
essential part
of the
modern
computer.
On older
models« and
today on
budget
models«
graphics
circuitry
tended to be
integrated
with the
motherboard
but« for
modern
flexible
machines:
they are
supplied in
PClc AGP.
When the
IBM PC was
introduced:«
many
existing
personal
computers
used text-
only display

Video card:
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adapters and
had no
graphics
capability.
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Disk Operating System (specifically)
and disk operating system
(generically)« most often abbreviated
as DOS (not to be confused with the
DOS family of disk operating systems
for the IBM PC compatible platform)«
refer to operating system software
used in most computers that provides
the abstraction and

management of

secondary storage devices and the
information on them (e.g.« file
systems for organizing files of all
sorts). Such software is referred to as
a disk operating system when the
storage devices it manages are made
of rotating platters (such as hard
disks or floppy disks(.
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1. Printing the Document
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Display a Document in Print Preview

On the Standard toolbar:« click the Print
Preview button.

Change margins in the Print Preview window

Use the Rulers in the Print Preview
windows to change document margins.

See multiple pages of the document at one time

On the Print Preview toolbar« click the
Multiple Pages button. Drag across the
number of pages you want to see.

Adjust document length

In the Print Preview windowz« click the
Shrink To Fit button on the Print Preview
toolbar.

See one page of a document in Print Preview

On the Print Preview toolbar:« click the One
Page button.

Print all pages of a document
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On the Standard toolbar« click the Print




button. In the dialog box« choose Print.

Print selected pages

On the Standard toolbar« click the Print
button. Click the Range button. In the Range
dialog box« enter the specific pages you want
to print in the Pages box. In the Print dialog
box« choose Print.

Print a document from the Print Preview
window

On the Print Preview toolbar« click the
Print button. In the dialog box« choose Print.
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2. Establish the Page Look and Proofing It's Contents

Use the Word thesaurus Select a word or phrase in the document« and
then choose Thesaurus from the Tools menu to
see synonyms:« related words« and sometimes:
antonyms.

Check grammar and spelling From the Tools menu« choose Grammar. As
possible grammar spelling errors are flagged:
make the suggested changes or ignore them.

Add words to the custom dictionary During a spelling or grammar check: click the
/Add button in the dialog box to add a correctly
spelled word to custom dictionary.

Establish document margins From the File menu« choose Document Layout.
Click the Margins tab. Or in the Page Setup
dialog box: click the Margins button.

ISelect paper size and orientation

Number all pages except the first From the Insert menu« choose Page Numbers.
Clear the Show Number On First Page check
box. Select additional options to format and
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position the page numbers. Choose OK.

Create a header or footer From the View menu« choose Header And
Footer. In the header or footer area« type the text
or click the buttons on the Header And Footer
toolbar for the data you want to appear.

VView Page numbers and headers and footers||Choose Page Layout from the View menu or
choose Print Preview from the File menu.

Alternate headers and footers for facing From the File menu« choose Document Layout
pages On the Margins tab« click the Mirror Margins
check box.
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3. Creating Tables and Charts

Insert a table

On the Standard toolbar« press the Insert
Tables button« and then drag to select the
number of columns and rows you want.

IMove to a new table cell

PPress the TAB key or use the arrows keys.

Select an entire column or row

Click above the column or in the selection
bar to the left of the row. Select an entire
table by choosing the Select Table
command from the Table menu.

Adjust the widths of table columns

Drag the columns markers on the ruler.

Insert a new row or column

Select a row or column in the existing
table« and then choose the Insert Columns
command from the Tables menu or click the
Insert Rows or Insert Columns button on
the Standard toolbar.

Delete a row or column
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Select the row or column« and then click the
Cut button on the Standard toolbar.




Add redefined formatting to table

From the table menu« choose Table
IAutoFormat. Then select the kind of
formatting you want.

\Add custom borders to a table

Select Table. Click Borders button on the
Formatting toolbar« and then select the
borders and line width you want.

Add custom shading to a table row

Select table. Click the Borders button on
the Formatting toolbar« and then select the
shading you want from the Shading drop-
down list.

Center a table between the page margins

From the Table menu« choose Select
Table. From the Table menu« choose the
Cell Height And Width command. On the
Row tab« select the Center option under
Alignment.

Create a bar chart

177

On the Standard toolbar« click the Insert
Chart button. Use the Chart Wizard or the
Graph menu and toolbar to select chart

options. Resize the chart if needed. Click




anywhere in the document window outside
of the graph to close the Graph application
and return to Word.
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4. Adding Graphics and Emphasizing Text

Display the Drawing toolbar On the Standard toolbar:« click the Drawing
button.

Insert a graphic From the Insert menu« choose Picture. Select the
name of the graphic you want to insert. This
graphic comes in as an inline graphic which means
it is not independent and can only move with your
text.

Size a graphic Select the graphic. Drag the corner handles to
size the graphic proportionately« or drag the
middle handles to stretch the graphic.

Frame and position a graphic Select the object you want to position. On the
Drawing toolbar« click the Insert Frame button.
\With the four-headed arrow: drag the item to
position it on the page. Framing an object makes it
an independent graphic.

To prepare an object for layering From the drawing toolbar select the text button«
with the cross hairs drag a bounding box to accept
the graphic. From the insert menu« choose
Picture. Select the name of the graphic you want
to insert. The graphic will appear in the bounding
box.

sttt s
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Layering two objects Both objects must be in a text frame. Select the
object you want in the back« from the Drawing
toolbar select the Send to Back button.

Change the border of a framed text Click the frame to select it. From the Format
paragraph menu:« choose Borders And Shading. Under Line«
click the type of line you want« and then choose
OK . Or on the borders toolbar« select a line style
from the Line Style drop-down list and click and
Outside Border button.

Edit a graphic Double-click the graphic in the document. The
application in which the graphic was created opens
S0 you can edit the graphic. Exit the application to
return to the document.

Crop a graphic Hold down the SHIFT key as you drag a sizing
handle.

Add shading to text Select the text. From the Format menu« choose
Borders And Shading. Choose the Shading tab. In
the Shading box« select the percentage of shading
that you want. You can also use the Shading drop-
down list on the Borders toolbar.

I |
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Display the Borders toolbar

On the Formatting toolbar« click the Borders
button.

Insert a drop cap as the first character in
a paragraph

From the Format menu« choose Drop Cap. In the
Drop Cap dialog box: click the style of drop cap
you want. Choose the OK button to return to the
document.

Start WordArt

Select the text to modify« and then click the Cut
button on the Standard toolbar. From the Insert
menu« choose Object. Choose Microsoft
WordArt2.0.

Create a WordArt object

Start WordArt. Type your text in the Enter Your
Text Here box. Click the Update Preview button
to make any changes in the text. Choose the OK
button to exit WordArt.
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Top 10 Reasons to Get Windows XP Home Edition

these are the 10 at the top of <While we can think of hundreds of reasons to use Windows XP Home Edition

our list.
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Help Protect Your PC
QAutomatically keep your PC up-to-date with the latest security enhancements including the Windows

and more to help protect it from viruses and worms that can « Windows Firewall:Security Center

spread through the Internet.

% Set Up and Share Your Computer Quickly and Easily
Q and an Internet connection in your « devices: printers:Quickly set up and connect all the computers

home with the all new Network Setup Wizard. Sharing a computer with others has never been easier;

quickly access your personal files and accounts without having to close applications or restart the
computer.

3 Easy to Use
Q « simple design of Windows XP puts the features you use most often at your fingertips<The clean

helping you find them quickly.
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As introduced in the previous lesson« in a network« computers and optional
other devices are connected to share resources. When a computer or device A is requesting a
resource from another computer or device B« the item A is referred to as a client. Because all or
most items that are part of a network live in association or cooperation« almost any one of them
can be referred to as a client. Based on this« there can be different types of clients. The most
regularly used of them is referred to as a workstation.

As its name implies¢ a workstation is a computer on which a person performs everyday regular
assignments. A workstation is primarily a personal computer (PC). It can also be a laptop. You
have probably used PCs so far. Almost any modern PC can be used as a workstation and
participate on a network.

Before building a computer network« when planning the workstations« you may be in one of the
following scenarios.

Jaad) cildaaa 2
If you already have one or more computers that you plan to use as workstations« you can start by
checking the hardware parts installed in the computer. The computer must meet the following
requirements:
Processor: An Intel Pentium or Celeron family of processors or an AMD K6/Athlon/Duron
family of processors. The processor should have a 300 megahertz clock speed. A higher speed is
recommended.
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To check the speed of the processor of a computer« you have many alternatives:

When the computer starts« you can access its BIOS by pressing F2 or F8 depending on the
computer« the model or the manufacturer
From the computer's desktop: if it's running Windows 95 and later« you can right-click My
Computer and click Properties
You can open Control Panel and double-click System
With these two previous options« you can see the processor's speed in the Computer section of
the General property page.
As another alternative to check the computer's processor« from Control Panel« you can double-
click Systemc« click the Hardware tab« and click Device Manager. In the Device Manager
window: expand the Processors node and double-click the first node under Processors. Here is an
example:

Jssig il 4
In most cases: if your computer is running Microsoft Windows XP Home Edition:« it should be
ready for Windows XP Professional. If the computer is running another operating system but it
appears to be too slow: you can replace its processor with a faster one. Before replacing a
processor« you must first find out what type of processor your computer use. You cannot just
replace any processor for another.
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To know the type of processor your computer uses« you have three options:

You can check the documentation (manual or user guide) that came with your computer. A page
in it should describe the type of processor your computer is using. You can write it down and«
when you go to a computer store or to a web store and use this description to purchase a new
one.

If you purchase or acquire a processor« it is usually easy to install and it comes with easy-to-
follow instructions. You will need to open the computer. It may be a good idea to take it to a
computer store or a computer repair shop and have them replace the processor for you

RAM: The computer must have a memory of at least 64 megabytes (MB). As memory is not
particularly expensive nowadays¢ you should upgrade the computer's memory to at least 512MB

If your computer doesn't have enough memory« you can increase it. Like a processor« different
computers use different types of memory. Before changing or increasing the memory of your
computer« you should find out what type it takes. As mentioned for the processor« you can get
this information by consulting the manual it came with« by opening the computer« or by calling
the manufacturer.
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Introduction to Windows Vista

Internet« the information super highway« has provided a reason for millions
of people to use faster PC using Windows Vista operating system that manages
the increasing amounts of digital information exchanged seamlessly.

No doubt: there are many tools available for managing this information but
these tools are not sufficient for today's speedy world¢ it requires more.
Microsoft's Windows Vista operating system is designed to give you more than
you expect from it. Now you can optimize Microsoft Windows Vista according to
your needs.

Microsoft assures you that Windows Vista will bring transparency to your
world« so you can more safely and confidently rely on your PC. Get more lively
multi-media experience with dynamic audio-video output¢ music and TV«
exclusively on your Windows Vista-based PC.

Windows Vista also enables you to always stay connected to the people
who are important to you from anywhere. Windows Vista always supports you to
do what you dreamt of.
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MEMORY MYSTERY SOLVED« CASE CLOSED

Finding a memory upgrade for your computer doesn't have to involve a lot
of detective work. With just one click« the Crucial System Scanner takes the
mystery out of finding the right RAM.

You know that you're ready for better performance by upgrading your
system memory« but you're not sure WHICH memory is right for your computer.
You might not even know your computer's manufacturer and model< much less
anything about the mind-boggling mix of memory shapes« sizes« speeds« and
capacities.

So how are you supposed to know which upgrade to buy? Don't spend
hours tracking down the right memory — let the Crucial System Scanner take the
guesswork out of upgrading! In just on click¢< our System Scanner tool analyzes
your PC's configuration« then automatically recommends the exact upgrades for
your system.

CLUELESS ABOUT MEMORY UPGRADES?
Just click the Scan My System button at Crucial.com« then sit back and get
your report on the upgrade that's right for you!
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Add an item to the Send To menu

When you right-click a file name or a thumbnail in Microsoft Windows XP« you see
a shortcut menu for that file. One of the items on the menu is Send To« which enables
you to quickly e-mail a file« copy it to your desktop« or copy it to a floppy disk.

Sometimes what you really want to do is to save a copy of the file to a specific
folder on your computer. If you have a folder where you frequently place files< you can
add that folder’s name to the list of locations on the Send To menu. This can save you
the time of opening another Windows Explorer window and copying the file from one
folder to another.

For example« you could create a My Pictures folder and then use the Send To
menu to copy your best pictures to that folder.
To add a folder to the Send To menu

1. Click Start. Then« click My Computer.

2. In the My Computer window: click the Tools menu« and then click Folder Options.

3. Click the View tab. Under Hidden files and folders« click Show hidden files and
folders« and then click OK.

4. Inthe My Computer window:« double-click Local Disk (C:)< double-click Documents
and Settings« double-click your user name:« and then double-click Send To.
Click the File menu:« click New« and then click Shortcut.
The Create Shortcut Wizard appears. Click the Browse button.

7. Inthe Browse For Folder dialog box: click the folder you want to add to your Send
To menu« and then click OK.

8. Click Next.

9. Click Finish.

Now when you right-click a file and click Send To« the destination you selected will be
an option on the Send To menu. You can create shortcuts to local or network programs:«
files« folders« computers« or Internet addresses.
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Telin e uai 2
Microsoft Virtual PC 2007 !

Better security« improved performance: faster searching and a stylish new interface are
| just some of the reasons you might want to upgrade to Windows Vista in the near future. But
i you'll probably have worries« too. The new operating system has undergone some fundamental
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changes since XP« and it's quite possible that many of your applications won't run until they've
been updated to be Vista-compatible.

Don't give up on your favorite programs just yet« though« because Microsoft has a solution
that may well help. Install Virtual PC and it will create a sandboxed environment in which you can
set up and install Windows XP (or Windows 98¢ Me« 2000 or even Windows NT: if you've got a CD
and license key). And Virtual PC keeps everything away from your actual operating system so it
won't get messed up.

While this type of virtualization technology is incredibly useful« it still has limitations. It
will share your host PC's memory:« so you'll need at least 1GB. And your Virtual PC doesn't
emulate DirectX¢« so you can't use it to play games or 3D applications. 2D applications perform
very well< though« making this perhaps the most convenient way to use other operating systems
on your current Windows installation.
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Three Simple Tips to Make Your Computer Run Faster

First of all< there are two ways to make your computer run faster: hardware and software.
Hardware boosting involves upgrading and adding new components to the computer to increase
its speed and performance. Typical upgrades include installing more memory« purchasing a better
motherboard or getting a better processor.
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Software optimization< on the other hand« does not require purchasing anything; it only
requires that you optimize and fine-tune your software set up and installation to make your
computer run faster. Here are a few ways to accomplish this type of optimization.

1. Uninstall unneeded applications - Over the course of your computer's lifetime you may have
installed a bevy of applications< many of which you do not need anymore. If this is the case« then
now is the time to get rid of them. This will make your computer run faster< and more efficiently.

Start off by going through your uninstall menu and look for applications that you do not
need anymore. These programs will usually have their own uninstall routines that will remove all
files and services they may have installed.

Most applications install applications that eat up not only disk space« but valuable RAM.
As your computer starts up« these programs start up too« eating precious processor time as well.

Some programs do not have their own uninstall routines. You may have to use custom
uninstall applications to remove these files from your computer. Make sure these applications
remove both the program and the supporting files it is packaged with. Also make sure that
registry entries regarding this application are also removed.

2. Defrag at all costs - Run a defragmenter application regularly. Data in a hard disk is not
necessarily stored in a contiguous manner. This means that when your hard disks read datac it
has to jump from platter to platter« sector to sector just to get a file in its entirety.

If your data is located contiguously« then this problem could be avoided:« saving your hard
disk valuable read time. And as a result of this effortc your computer could experience faster disk
reads and an improvement in computer speeds from 30% up to 100%.

3. Check for Viruses - Install a handy antivirus to help weed out those pesky codes that could
seriously compromise your data's security« integrity while slowing your computer at the same
time. A well-infested computer will typically grind to halt as malicious code use and abuse
precious computer resources.

There are many antiviral agents around« aside from installing such« avoid the spread of
viruses by making sure you only use removable media that is from verified sources. Also:« be
careful of the sites you visit as they could contain online malicious code.
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BILLQUICK 2006 7.0.84

The last thing a small business on a tight
budget needs is to buy expensive software to
track invoices and perform other project-
management functions. BillQuick offers more
than 400 templates for various types of invoices
and reports that cover a multitude of professions.
Plus« if you already own QuickBooks: the latest
version of BillQuick has improved its integration
for the program.
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WORDWEB 4.5A

Whether you're online or offlinec WordWeb
can serve as your personal dictionary. You can
set up the utility so that when you highlight a
word and click a hotkey« the word's definition
pops right up. WordWeb will also provide
synonyms and antonyms. With more than
150<000 words in its dictionary and almost
120000 synonym sets¢ WordWeb is never at
loss for words.

&) 4.5 JuaY) cug g
(WORDWEB 4.5A)

By el (a5l 8 Jranlls s 3 ) el n o 58
A5 (s e AalS ol a5 13) 40 Gy el yall dlae
uﬁ)AJ}C.ADJJeMg\AS‘MMLm)dSJéQH
IS Qall 150 o ST 2 ga gad cchlabiaiall g cHlaal yidl)
Gl 120 b Lo (M ALY il (el d 8
i Y s 5 el Gl A i) (e Ao gana

Aal) LS an T

A LSy ) gt

AVG ANTI-VIRUS FREE EDITION 7.5.4

The first line of defense for any PC is a good
virus Kkiller. AVG Anti-Virus Free Edition
protects your computer for nothing. Like any
commercial virus-busting app< AVG scans your
system and e-mail for virtual nasties¢ and
automatically updates itself with new virus
information. Plusc the latest wversion is
compatible with Windows Vista.
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Cila g M) (i glis

guaranteed annual wage

Osaaall g sill jaY)

GigaBit

S Gl

GigaByte

b el

general business conditions

dale 4y lad by s

GigaBit Interface Converter

< Lagall gl 5 J g

Group Buffer Pool

RN YN

Giga Bits Per Second

40N B ey gl

Health Behavior Information Transfer

ol & glal) cila glaa Ji

Hardware Compatibility List

J) o O53) 834l (358 Aaild

High Capacity Storage System

A Gl ) o ) BB A allaS

Home Computer User

3 (e U)o gl Jarina

Hard Disk; High Density

Head Disk Assembly

i M) el g

High-Density Bipolar 3

3 AU e ) S

Hard Disk Controller; High Dependability Computing

clall pa Al 43 54

High Definition Compatible Digital

éé\gﬁ\ééwédﬁ!@bdﬁﬁgﬁJ

Hard Disk Driver

lal) Ga il Jida |

High-level Dialogue Definition Language

GM\@LQM;J\@;JZ&J

High Definition Digital Video (or Versatile) Disk

Ao (Ylaind) amia o) a8 0 sl o B
iy i)

Hierarchical Data Format

A gl @il ddsa

Integrated Advanced Information Managemant System

goasall adiiall e glaall 5 a3

Index allocation map; Internet Answering Machine

U Aagal) Y a0 A (el Bac )
(@)

Internet Access Policy; Internet Access Provider

AN Aadd 395 i AN Jsaa Al

Information Access Service; Interactive Application
System; Internet Access Server

06 i) il aUAS (e glaall g gl) Aad
Y Y Jgagh add

Import Address Table; Information Access Technology

Jdsa sl Lia gl 5SS (B3 ghsall Gaglindl J 93>
e glrall

International Business Machine

Loallad) Jaad) A1

Integrated Business Network

Lasall A i) AL)

In-Band« On-Channel

Jual ‘5,3‘9 a3)a LJ&

International Bank for Reconstruction and Development

(Basial) ad¥l) L& g jrarill A gal) L)

In Before The Lock

JEEY) 38 Jsad

Information Behavior and Value

e slaad) & sl g Aal

Input Circuit; Integrated Circuit; Internet Connector: | See

Ul el i) Juaga cdaadal) 3 yilal) (JALY) B yila
pedsl

Java 2 platform« Enterprise Edition

£ 5 pall Adai (2 Wl gral 3

Java 2 platform« Micro Edition

\493)@4&&‘2&14@13),1

Java 2 platform« Standard Edition

Al A 2 By gali

Jump if Above

13 5

Java Authentication and Authorization Service

Ll (2 98 g Ah g g daad

Joint Application Development
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Jasmine Application Development Environment

Canalal) il g ghati diy

Java Advanced Imaging

efﬂ.d\ lél% Hyal

Java for the Advanced Intelligent Network

Lasiial) 1) G A8

Just A Minute

XE “‘:.\

Java Apache Mail Enterprise Server

Bla il £ g e pdd

January

(A5 O5iS)

Joint Academic NETwork

A diall dpanalsy) A<l

Java ARchive

lél@ A "Ji

Keep Alive Memory

dga §SIAL LaldtaY)

Kiva Administrative Server

s (1Y) adad)

contract award date

Shal) 5B ey

kilobyte; Knowledge Base

KeyBoarD

gilial) 4a gl

Keyboard [0S/2]

(28aluws) gl a8l

Knowledge Based Engineering

Bl o 5355 yal) Aig)

Kilobit

b 1= < 8 (eiddidaay) <o gl

KeyBoard/MouSe

8 il zilial) 4a o)

kilo bit per second

Kilobytes Per Second

TG b Culy sbs

Knowledge-Based System

keyboard unit

Kilocycle

Kilo characters per second

Key Distribution Center

K Desktop Environment

Sl g8 S
CiSal) pha Ay

keyboard data recorder

Al Za gl Gl Jaaa

Knowledge Discovery Server

e glaal) CiLES) aald

LAyered Device DRiver

Local Access Data Transport

el Jsa sl iy Jis

Large Area Electronic Display Panel

L5 S) Al gl ddhaial) a5 Ang)

Look And Feel

leaf area index

i) G jgh

LALOTA

lots and lots of thuderous applause

S50 2B G s L)

LAM

Local Area Multicomputer

aaiall el (V) i)

LAN

Local Access Network; Local Area Network

| ) A8 csdaall J gaa sll ASu

LANDP

Local Area Network Distributed Platform

Adaal) Auil de j gal) ddadl)

LANE

Local Area Network Emulation

Adaal) A0 BlSlaa

lang.

language

o

LAP

Link Access Protocol

Jua¥) Jasl ) J oS 5890

LAP

Link Access Procedure

iyl B s sl

LAPB

Link Access Procedure Balanced

351 i) Juai) sl

LAPS

Lan Adapter and Protocol Support

Y Jsaay JsS g an

MCSE

Microsoft Certified System Engineer

b gn g e (pa et dabiif (udigs

MCSP

Microsoft Certified Solution Provider

b g g S0a G daina Jola 394

MCT

Microsoft Certified Trainer

b gou g S0 (10 el e

MCU

Multi-point Control Unit; MicroController Unit; Multi-Chip
Unit

A38al) aSail) Baa g KAL) Badnia aSal Baag
Sasial) 4318 1) Bas g

MDA

Monochrome Display Adapter; MultiDimensional Analysis

Aag) daaia Julad ool dua g sledd) dadl ga

MDAC

Microsoft Data Access Component

b a9 e il Jguagll uaic

MDB

Microsoft DataBase

Cé}uj)s‘.'\a&ugg;.\a@

MDBE

Microsoft DataBase Engine

18 g 5 jSaa il BaslB & o

MDBMS

Multidimensional DataBase Management System
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http://www.c4arab.com/qamoos/mean.php?word=Kilocycle
http://en.wikipedia.org/wiki/KDE

Network Adapter Card; Network Administration Center

M\ 3l & e sM\ dwﬁlhg

Negative Acknowledgement

Al lad)

Number Assignment Module

Qu+mdﬁgy¢§hjl

Narrow-band Analog Mobile Phone Service

B_shaal) dajad) cald Agalalyl A4S adl) i) ged) daad

Not A Number

Lad

network access point

A<l Jlany) ddads

Network Access Point

LAl guan o) a3

Network Application Programming Interface

ALl ikl daa p dgaly

Narrow

"

&

Network Application Support

TE i e

National Advanced Systems

Al olf daxiiall Aty

Name/Age/Sex/Location

& sallf il yandlfay)

Network Accessible Services Specification Language

L) Jgma sl (S Al A ciladd Cia g dad

Network Address Translation

Al o)) gl dan

Network Address Translation

Aal gl daa i3

national; natural

b oAby

North Atlantic Treaty Organization

b Juad dila

Network Address Translation - Protocol Translation

Al o i Aax i - JoS sign Aaas |f

Network Access Unit; Network Addressable Unit

L ginal) A, Ban g ASuil) ) J gl 320 |

Network Addressable Unit

4 giall AL080 4S80 Bas

numbers

)

Note Board Keyboard

Jsanal) culall Ladia eilia 4a 41 |

Non-Breakable SPace

FHEEURIWENETE |

network computer

Net Citizen

Open Architecture Driver

da gidal) i) Jriia

Official Airline Guide; Online Air Guide

UJQ ‘539.“ Jalaly sg.AuJ.“ 2\,.391\.&32511 Jala
Al

Open Applications Interface

da gidal) cligdatl) dgal s

Operations« Administration< and Management

319 Gl g cilalaadl

Organization of Arab Petroleum Exporting Countries

(& f) Jadill 5 )0l Ay sl J gal) Aakiia

Oracle Application Server

JS‘J"i Qw eé&

OASIS

Open Access Same-time Information System;
Organization for the Advancement of Structured
Information Standards

Llial) e glaall (punlBa  ghat

OASYS

Office Automation SYStem

4gal) Jlas ) Aialf allas

ob

obvious

caly

OBl

Open Buying on the Internet

i) e g sikal) £ yad)

OBJ

OBJect (File name extension)

(S5as e aal) gl

Object OLE

object linking and embedding

Apadailg oy (e (S

OBO

or best offer

vas Jabi

OBS

Old Backup Server

Héﬁ\ ‘a“-é.“ ‘4.\1&

PAM

Portable Access Mode; Positronic Artificial Machine; Pulse

amplitude modulation

Adall A ganal) Jouagll dBy ke gda s
435 pual) Y (Positronic A

PAN

Personal Area Network

dald e i) Al

PAP

Password Authentication Protocol

Ayl Al (365 J S g9

PAR

Positive Acknowledgement and Retransmission; Personal

Animation Recorder

(il A Al Janua ¢l A<l g Sl ) Bals)

par.

paragraph

5y

para

paragraph

5 jab

Parl.

Parliament
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passage

o e

Program for Appropriate Technology in Health

daall b Laidall L ol gisill el |

payment at time service

Lasil) o085 dic Axby

Private automatic exchange

Sl gig) il gili J) i

payment

Lasil) o5 dic A2y

PB SRAM

Pipelined Burst Static RAM

aly 3SIA ()18 e Jlae

PBRAM

Pipeline Burst RAM

3SIA IR s Jhae

PBX

Private Branch Exchange

wald (o8 Jald S e

PC

Passable Calculators; Personal Computer

pc.

piece

et culal) (Jlaxin) Adga daala &Y
I

PC/SC

Personal Computer Smart Card

i) V) quall LX) Ak

PC/TV

Personal Computer and Television

g.aa'm.ﬂ\ Al g cualad)

PCA

Physical configuration audit

@akall JaSiil) day ya

PCB

Printed-Circuit Board

‘K.GL_th.“ CJSQ\JJ-\

PC-DOS

Personal Computer Disk Operating System

addl) quulall ga B Jads AU

PCFES

Personal Computer File System

PCI

Peripheral Component Interface

Lkl il o<l dgaly

quick back-up

Mﬂ&m;\éﬁuil

G Cad

Quality Control

53 gadly asadil)

Quantum Chromodynamics

LSaalial) o 9l Lus [f

Quarter Common source Intermediate Format

(144%176 43Sy 518 4iw) QCIF 4in

Quantum Cascade Laser

Qualitative Data Analysis

Quicken Data File

Quicken Dictionary

Quick and Dirty Operating System

B g Jaui ol

Quad Data-Rate

8_paiiall bl Jana ||

Quicken DaTa

3&5‘)“31 G:IUL):\S‘

Queued Event Architecture

FERETREX I I

Quality Evaluation Organization

3agally (uliall dakaia

Qualified Economic Offer

Jrisa aal G £

R/O

Read Only

La8d 3¢ 3l

R/T

Receive/Transmit

Cayf Juins)

R/W

Read/Write

PR

RA

Remote Assistance; Return Authorization

3agadly G ofill cary (e Baclusal)

RAC

Real Application Cluster

Ahal) clipdall 4 gana

RACF

Resource Access Control Facility

Sl L)) JA L) e dark

RACMan

Remote Automation Connection MANager

2 08 Sl Y1 Juai) e

RAD

Rapid Access Disk; Rapid Application Development

oSkl Jedall e b

RADAC

Ram Digital-to-Analog Converter

Allas @ L) ) Al ) ) LB o) J gaa

radar

radio detection and ranging

ELdall Gl ga Aaai) gy 3l g (LSl aa

RADB

Routing Arbiter Data Base

Il clly sl

RADSL

Rate Adaptive Digital Subscriber Line

Sl b)) & il Bd Jara

RAG

Row Address Generator

plal) g glind) alga

RAI

Rapid Application Integration

Zag o) kil gra

RAID

Redundant Array of Inexpensive (or Independent) Disks

(Miiecal) ) dad 1) Gal B3 4 ghal) 43 giaal)

RAIS

Redundant Arrays of Inexpensive Systems

duasd ) dalaiD A ghaal) il ghuaall

RAIT

Redundant Array of Independent Tapes

duasd ) dda i A glaall 48 giiaall

RALU

Register-equipped Arithmetic Logic Unit

Sl 5 5gaall Adlaiall cibucaly ) 5aa g

RAM

Random Access Memory

A sdal) Jagh 5503

RAMDAC

Ram Digital-to-Analog Converter

Agalal ) Aad )l al ;3 803 J o

RAMP

Remote Access Maintenance Protocol; Risk Analysis and
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I Management Program I

Radio Access Network

s e Jeaal A

RANDom; Research and developed

s#}hﬂ\‘gw‘ ‘g—ﬂﬁﬁ

Shared Access Transport Facility

Ja) Aeadd & i) J guaa gl

Single Application Virtual Dos Machine

3a_ial) Lodal BN (pu g3 i’ A5

Small Business; Sound Board

Gpall dagl  piua g lad Jas

Service-Based Architecture

Aaadl) ) fatioall A1)

Satellite Computer; Semi Conductor

Al Juagall < g _all) alal)

scale; scene

i o) e

Synchronous Concurrent Algorithm

438) giall a3 ) sad) (pal

System Control And Data Acquisition

L Judod g aSail) B

Source Code Control Interface

J3all jluass aSatl) dgaly

Signaling Connection Control Part

8 LAY Aoyl s aSadl) £ Ja

Source Code Control System

330 dany aSal) ol

Service Control Device; Slowly Changing Dimension

s piiall dl) (daddll aSadl) jlga

Saudi Consolated Electric Company

L grd) sl gl A8,

school

L..Ju

science fiction

Typing on 9 keys

feilha dads o dekl)

Technical Assembly; Terminal Adapter

i ylaY) Ala g Agidl) A ganall

tablet

TABulator

table

total audit concept technique

TransAction Number

There Ain't No Such Thing As A Free Lunch

S 12 e Jaal 2

Track-At-Once (CD recording methodology)

(Raata gal B Joeds Ay yh) 3 yeilsa ail)

Technical Advanced Placement; Telocator Alphanumeric
Protocol; Terminal Access Point; Test Access Port

b ) J oS g g catiial) I ALl il
JHEA (A ) Jlaiy) Akl ¢ g3l A al)
Jaad)

Telephony Application Programming Interface

Alilgd) il daw  dgals

Tape ARchiver

Al ,aY) s

telephone answering system

g 3

Task Automation Scripting Kit

Gkl 3 5gal 8 Jauads 51

Turbo ASseMbler; Turbo ASseMbler programming
language

Al ey o gealas el ¢ A gl el

Universal Asymmetric Digital Subscriber Line

rallad) JiLaiall a1 & idiall ok

United Arab Emirates

Saatial) Ay al) & jlay)

User Authorization File

adiicall (a 5ii Cila

User Agent accessibility GuideLines

?M\ a8 Juall clald )

User Authentication Method

padicual) ABilaa o glud

Universal Application Network

Lallad) i o) Al

User Acceptance Program; Unified Approval Procedure

.\AJA.“ djgﬁ\ ﬁ‘ﬁ! ‘aw‘dﬁg@liﬁ

User Agent Protocol Data Unit

,a.\i:wud\ d;\Sj Gl Baa g

Universal Asynchronous Receiver/Transmitter

0B A Al Gl Fin Jetiens] Jot o

United Arab Republic

Baadall Ay all &y ggeall

Unit Activation Schedule; User Application Software

‘aM\ QL%_.).}H Gl g ‘34535\ m @AU)Q

User Acceptance Test

pdiicudl) (58 g

User brain damage

pdial) Jis & Jhe

Unsolicited Bulk E-mail

Golha pad) g AN &l

Universal Business Language
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Universal Broadband Router; Unspecified Bit Rate

Saa e Cu Jira o allad) Al ol aall A ga

Under Construction

sl Cuald

Ultimate Computer Acronyms Archive

Aulad) AV el @) atid) Cind i

University Corporation for Advanced Internet Development

adiiall i Ay skl 4S i Azala

Unit Control Block

?SL'\.“ Suji\.&:\s

Unsolicited Commercial Email

Gtha sl o ladll g A 4l

Voice Answer Back

Syl il sa gl

vacuum

§ e Al S duita

voice analyzer and data converter

Ggall Haa g @il Jsaa

very-high-rate asymmetric digital subscriber line

123 ) g el a8 ) Al jidall Baa

Visual Age for Java

G@émﬁ.\)ﬂ\

VALue; Voice Application Language

T gl il ) Zatied

Virtual Access Method

) 58 Juaty) 48 4k

Value-Added Network; Virtual Access Network

A A8 Juaiy) Al Al ) ALl dadl)

VANcouver Data Language

RS el 4sd

Value Added Process; Value Added Provider

ALzl Aadl) 393 caglanl) ) ABLaal) Aadl)

virtual application programming interface

Al 8y lidail) daa s Al

variable; variant

varying radiation

AL plady)

variable resistor

variable-voltage transformer

8 el 4l 4d) J g2

Windows 2000

2000 Jyiy

World Wide Web

Loallad) Apadl) ASLE)

World wide web applets; World Wide Web Consortium

M\ m‘ Alad) ‘4133‘”5..!.“ 4"5. ) (5:'&5
Aallald)

What-work-with-what

1 3agea-Jlas 1-)3e

windows application binary interface

L) clidal) 3 65 dgals ||

weapon aiming computer

Y sl Ao gy dga 9o dalud

(Wait before Tramsmitting positive Acknwoledgemen)

bl Ju ) g BV a5l Jlad)

With all due respect

wide area data service

4a) jial) cililud) dadd

when actually employed

il il s e

Wireless application environment

Lo i) cilgalal

Women in the air force

Wireless Applications Group

Asladlll cliylall) 4 gana

Web Accessibility Initiative; Web Application Interface

m‘ Gl a@é\‘g Juﬁ_ﬂﬁ‘ U“; Juaiy b yalsa

Web Accessibility Initiative Protocols and Formats

1A o Jual¥) 50 fmay oY oS 55

Wide Area information Server (or Service)

Uail) Aral g cila shiall (Aa2d gi) add

WAIT for Interrupt

dakaliall i)

Wide Area Information Transfer System

4al sial) e glaal) JAS aldai

Wide Area Network

Aga) piall cilpadald) A0l

Wireless Application Protocol; Wireless Access Point

oSLasll) JLaiy) Ak (ASLudl) i) oS 5 g

Xml Active Content Technologies

3 ) 81 3 Al Gy giaall L o155

eXtensible Business Reporting Language

A gl Ay jladl) Al A

Cross country

Bl sy

Experimental computing facility

Culall alal) aladal) audits

ExCHanGe

Jas

eXternal CoMmanD

2B

extended copy

E.c 1 .

eXtended Copy Protection

S iaall Adadl) Llaa

eXtended Development Experience

Siaall Ly ghall 5

Extended Density Format
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X Display Manager

) pals e

Extended Data Representation; eXternal Data
Representation

dga A Uil Jiad cataall clibal) Jdal I

Xml Data Reduced

Labial) J) af oas) bty I

eXternal FunCtioN

Laal a2 29 ||

eXtensible Forms Description Language

Buliaal) JLSEY) Cina g 4t [

eXtended Graphics Array

Baiaal) ) guall 4a glile

eXtensible Graph Markup and Modeling Language

Z\_:.hﬂu Baiaal) W| Jsall FH]

eXtensible HyperText Markup Language

Sataal) dgmdiall (a guaill dad

eXchange ldentifier

Gi_ial) )il

extended integrated data base

aiaall daasal) i) 5acld

eXternal Interface File; Xml Interchange Format

31 ) ) Jobi D T ) g ol il

eXtended Image File Format

Baiad) sl cile dipea

X Imaging Library

OS] g A

Crossing

5=

eXtended Input/Output System

Ll £ AY g Y i

yearbook; YottaByte (1024 zetabytes)

(< 3 1024) < Uigy ¢ g giaad) SIS

yellow card (soccer)

(PR 5.5) #1hua iy

Zone Improvement Plan (ZIP code)

(2 3a ) dlhaial) fpuat dbd

zone information table

Aahid) cla gl Jga

Zoom Lens Reflex

Ldad) cluand) puised ]

Zero Network Administration

4 hal) Al 309 ||

zone of protection

zero pouplation growth

S SSad) salll Jana [

Zoomed Port Video
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